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Artifact Rationale

Per the Veteran-focused Integrated Process (VIP) Guide, the User’s Guide is required to 
be completed prior to Critical Decision Point #2 (CD2), with the expectation that it will 
be updated as needed. A User Guide is a technical communication document intended 
to give assistance to people using a particular system, such as VistA end users. It is 
usually written by a technical writer, although it can also be written by programmers, 
product or project managers, or other technical staff. Most user guides contain both a 
written guide and the associated images. In the case of computer applications, it is usual 
to include screenshots of the human-machine interfaces, and hardware manuals often 
include clear, simplified diagrams. The language used is matched to the intended 
audience, with jargon kept to a minimum or explained thoroughly. The User Guide is a 
mandatory, build-level document, and should be updated to reflect the contents of the 
most recently deployed build. The sections documented herein are required if applicable 
to your product.
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1. Introduction
The Care Coordination (CC) Standardized Episodes of Care (SEOC) is a reference 
database for managing care bundles for use by Veterans Information Systems and 
Technology Architecture (VistA) and other Department of Veterans Affairs (VA) systems. 
Services are grouped together within the SEOC system into bundles so that clinicians 
can add these bundles to patients consult records in a standardized fashion, reducing 
the amount of time spent manually entering consult instructions, and providing 
uniformity among the patient records and across facilities for how patient care is 
prescribed for similar complaints.

These bundles group together one or more services that are preselected for different 
specialties to be added to the consult records. In addition, the clinician is provided with 
information regarding prescribing rules and preauthorization requirements, so they can 
make the most informed decisions regarding patient care.

Additionally, SEOC data will be accessible outside of the VistA/Computerized Patient 
Record System (CPRS) system so that users of downstream applications will be accessing 
the centralized data, and SEOC descriptions, reducing the chances of disconnects.

1.1. Purpose
The purpose of this document is to provide instruction for utilizing the SEOC application 
to standardize and streamline consult management for Community Care.

1.2. Document Orientation
The Care Coordination (CC) Standardized Episodes of Care (SEOC) v1.21 Database User 
Guide will provide explanations of each screen and of all user interface options within 
the context of an easy-to-understand demonstration data scenario. 

This document is also designed to provide the user with screen-by-screen “how to” 
information on the usage of CC SEOC.

1.2.1. Organization of the Manual
Section 1: Introduction

The Introduction section provides the purpose of this manual, an overview of the SEOC 
software, an overview of the software used, project references, contact information for 
the user to seek additional information, and an acronyms and abbreviations list for this 
manual.
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Section 2: System Summary

The System Summary section provides a graphical representation of the equipment, 
communication, and networks used by the system, user access levels, how the software 
will be accessed, and contingencies and alternative modes of operation.

Section 3: Getting Started

Information for the Getting Started section provides a general walk-through of the 
system from initiation through exit, enabling the user to understand the sequence and 
flow of the system.

Section 4: Using the Software

This section gives the user the “how to” information to use SEOC, including many step-
by-step procedures.

Section 5: Troubleshooting

This section provides troubleshooting for the SEOC user.

Section 6: Acronyms and Abbreviations

This section provides a list of acronyms and abbreviations found in this document.

1.2.2. Assumptions
This guide was written with the following assumed experience/skills of the audience:

· The SEOC user has been assigned the user role of SEOC Analyst. The SEOC 
Analyst can view Active or Discontinued SEOCs on the Home Page. These users 
can View, Print, or Track Version Changes on selected SEOCs. 

· User has Google Chrome and/or Microsoft Edge installed on their machine.
· The SEOC user has basic knowledge of the SEOC system (such as the use of 

commands, menu options, and navigation tools).
· The SEOC user has been provided the appropriate active roles, menus, and 

security keys required for the SEOC User Interface (UI). 
· The SEOC user is using SEOC to perform their daily consult creation workflow and 

perform the required SEOC functions.
· The SEOC user has validated access to the SEOC UI.
· The SEOC user has been provided training on the SEOC UI and has reviewed the 

User Guide.
· SEOC Content Authors: The SEOC Content Authors are responsible for creating 

and update the content within the SEOC repository using the SEOC UI. These 
users are required to VA access rights and privileges and will sign on to the SEOC 
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application using their Single Sign-On Integration (SSOI) credentials (typically 
their Personal Identification Verification (PIV) and access code).

· CPRS Clinicians that are responsible for documenting patient consult records. 
These clinicians utilize the SEOC content as part of their daily consult creation 
workflow such that they will add a SEOC bundle to the patient consult record 
which will provide for a standardized documentation and care plan approach 
across the VA for these consults.

1.2.3. Coordination
One Consult - Consult Toolbox 1.9.02 and above and the HealthShare Referral Manager 
(HSRM) depend on the availability of the SEOC System. Consult Toolbox 1.9.02 requires 
active SEOCs whereas HSRM requires active and discontinued SEOCs. Coordination 
between the One Consult – Consult Toolbox, HSRM, and SEOC team is necessary with 
any updates to SEOC. 

1.2.4. Disclaimers

1.2.4.1. Software Disclaimer

This software was developed at the Department of Veterans Affairs (VA) by employees 
of the Federal Government in the course of their official duties. Pursuant to title 17 
Section 105 of the United States Code this software is not subject to copyright 
protection and is in the public domain. VA assumes no responsibility whatsoever for its 
use by other parties, and makes no guarantees, expressed or implied, about its quality, 
reliability, or any other characteristic. We would appreciate acknowledgement if the 
software is used. This software can be redistributed and/or modified freely provided that 
any derivative works bear some notice that they are derived from it, and any modified 
versions bear some notice that they have been modified.

1.2.4.2. Documentation Disclaimer

The appearance of external hyperlink references in this manual does not constitute 
endorsement by the Department of Veterans Affairs (VA) of this Web site or the 
information, products, or services contained therein. The VA does not exercise any 
editorial control over the information you may find at these locations. Such links are 
provided and are consistent with the stated purpose of the VA.
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1.2.5. Documentation Conventions
This manual uses several methods to highlight different aspects of the material.

Table 1. Documentation Symbols and Descriptions

Symbol Description
CAUTION: Used to caution the reader to take special notice of critical information.

NOTE: Notes are used to inform the reader of general information including 
references to additional reading material.

1.2.6. References and Resources
Readers who wish to learn more about CPRS and CC SEOC should consult the VA 
Software Document Library.

1.3. National Service Desk and Organizational Contacts
For issues related to the CC SEOC that cannot be resolved by this manual or the site 
administrator, please contact the National Service Desk.

2. System Summary
There was an immediate need to provide clinicians the ability to quickly and consistently 
add care bundles to a patient’s consult record within VistA. SEOC provides this feature 
for a higher level of uniformity in patient care, easier access to appropriate services, 
based on initial diagnoses, and the ability to better control care costs. SEOC allows 
clinicians to enhance the coordination of care for the Veteran.

The system contains SEOCs, or care bundles, that clinicians or other designated 
individuals can assign to VA patients. These bundles allow for the consistent use of 
procedures when certain conditions are diagnosed. This consistency allows the VA to 
effectively manage patient care and provides easier traceability.

2.1. System Configuration
The SEOC System is designed to be a simple reference database with a supporting SEOC 
Application Program Interface (API) and UI layer. The SEOC system comprises three 
application tiers as shown below.
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Figure 1: Overview of SEOC System

The first tier is the Data Tier. This tier contains SEOC data. SEOC uses Microsoft 
Structured Query Language (SQL) Server is the database. SEOC data consists of 
reference data, such as SEOC name, associated procedures, associated Current 
Procedural Terminology (CPT) codes, procedure durations, etc. Additionally, user role 
information is maintained within the tables, but no passwords or other credentials are 
stored. No Protected Health Information (PHI) or Personally Identifiable Information (PII) 
is stored in the database. SEOC data is associated with patient data in the VistA consult 
record.

The second tier is the Abstraction Tier. This tier acts as the data broker for the SEOC 
system. It is a Representational State Transfer (REST) API, built as a microservice hosted 
on container infrastructure (Docker Container). The API itself is built on the Spring 
Model-View-Controller (MVC) framework. The API receives web API calls that are 
forwarded to the database appropriately. Consuming applications are able to query the 
SEOC system through the SEOC REST API but will not be able to perform updated 
operations. The SEOC UI uses certificates to authenticate with the SEOC REST API to 
allow data modification within the SEOC system by authenticated users. Users are 
authenticated using SSOI. Additionally, a VistA/MUMPS patch is created to insert the 
SEOC associations into File # 123.

The third and final tier is the Presentation Tier. This tier consists of the SEOC UI, which 
provides a user interface for approved, authenticated users to maintain the SEOC 
collection. This application is a web application built as a microservice hosted on 
container infrastructure (Docker Container). The UI is built using the React.js JavaScript 
framework for web applications. 
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2.2. Data Flows
Figure 2: SEOC Data Flow Diagram

2.3. User Access Levels
SEOC user profiles comprise of the following “types of users”:

· SEOC Content Authors: The SEOC Content Authors are responsible for creating 
and update the content within the SEOC repository using the SEOC UI. These 
users are required to VA access rights and privileges and will sign on to the SEOC 
application using their SSOI credentials (typically their PIV and access code).

· CPRS Clinicians that are responsible for documenting patient consult records. 
These clinicians utilize the SEOC content as part of their daily consult creation 
workflow such that they will add a SEOC bundle to the patient consult record 
which will provide for a standardized documentation and care plan approach 
across the VA for these consults.

· SEOC data is also accessible to other external consumers in the future (in addition 
to CPRS users). The SEOC API is a RESTFul API that other (to be determined) users 
will have access to use.
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2.4. Continuity of Operation
The SEOC system is maintained by Enterprise Operations (EO). The continuity of 
operations is managed by EO. 

3. Getting Started
This section provides a general walkthrough of CC SEOC from initiation through exit. 

3.1. Logging On
CC SEOC is accessed using the VA SSOi log in. 

Figure 3: VA Single Sign-On for SEOC

NOTE: After 15 minutes of inactivity the system will automatically log you out. 
After 13 minutes of inactivity the system will prompt you to extend your 
session.
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Figure 4: 2 Minutes Until Session Expires Warning

3.2. System Menu
The Standardized Episodes of Care dashboard offers several features: Filter by Billing 
Code, Filter by Service Line, Filter by Status, Filter by Name, View Selected SEOCs, 
and Export SEOCs. The home page also displays the username and user role at the top 
right of the page.

Figure 5: Standardized Episodes of Care Dashboard

CAUTION: To view the list of SEOCs using a keyboard interface with assistive 
technology, you will need to use the “Tab” key to navigate through the list.
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Standardized Episodes of Care table fields:

· Service Line – A broad category of care for the services and procedures included 
which is intended to be used to group and filter SEOCs for easier accessibility. A 
standardized three-letter abbreviation of the service line is included at the 
beginning of the SEOC ID.

· SEOC Name – A unique title that categorizes a SEOC by specialty/subspecialty or 
area of clinical practice.

· Version – The version number of the SEOC. The version number is formatted 
A.B.C where the first digit will be 1, the second digit is the number of published 
SEOCs in the same Category of Care when a new SEOC is activated, and the third 
digit is a serialized revision number.

· Effective Date –The date the SEOC status was made from In-Progress to Active.
· End Date –The date the SEOC status was discontinued.
· Status –The SEOC statuses are as follows: 

o Active: When a SEOC is Active, it will be available for all end users (e.g. API 
users, scheduling, payment, and auditing purposes). 

o Date Hold: When the SEOC status is Date Hold, it is pending and set for 
activation on a designated future date. This status is only available for 
SEOC Administrative users for editing purposes. 

o Discontinued: When a SEOC is Discontinued, read-only users will not have 
access to the discontinued SEOC in the SEOC Database or the scheduling 
interface. However, the discontinued version will still be available for 
payment and auditing purposes. Discontinued SEOCs will remain in the 
SEOC database for up to six (6) years in the central repository.

o In-Progress: The SEOC is available for editing purposes by the 
Administrators and Authors prior to activation. These SEOCs will not be 
available via SEOC Database API. 

3.3. Changing User ID and Password
If you need to change your user password, you will need to contact your local PIV office.

3.4. Exit System
If you are finished working, log out of VA Single Sign-On and close any secure sessions 
that may still be open by selecting the Logout button.
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4. Using the Software
The CC SEOC provides user functionality for the following items: 

· View Selected SEOC
o View a Selected SEOC
o Search for a SEOC by Name

§ Sort SEOCs Alphabetically by Name
o Filter SEOCs by Status
o Print a SEOC
o Track Version Changes

· Export SEOC
o Export the SEOC Data to an Excel File
o Export the SEOC Data to a JSON File
o Export the VA PreCert Webpage Data to a JSON File

4.1. View SEOCs
4.1.1. View a Selected SEOC
To view a SEOC from the SEOC list, follow the steps listed below:

1. From the SEOC home page, select the SEOC you would like to view.
2. Select View Selected SEOC or tap the selected SEOC to view. The View SEOC 

page displays.
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Figure 6: View SEOC (1 of 2)

Figure 7: View SEOC (2 of 2)
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4.1.2. View Filtered SEOCs
SEOC allows you to filter SEOCs by billing code, service line, status, and name. You also 
have the option to sort the displayed columns by selecting the arrow to the right of the 
column heading name.

4.1.2.1. Filter SEOCs by Billing Code

To filter the list of SEOCs by billing code, follow the steps listed below:

NOTE: Those with a Viewer role are unable to filter SEOCs by billing code.

1. From the SEOC Admin home page, enter the billing code in the Billing Code 
Filter field.

Figure 8: Billing Code Filter Field

2. Select the Search button. The SEOC list refreshes to display the SEOCs list filtered 
by the billing code type.

Figure 9: Billing Code Filter Search Results
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4.1.2.2. Filter SEOCs by Service Line

To filter the list of SEOCs by Service Line, follow the steps listed below:

1. From the SEOC Admin home page, select Filter by Service Line menu.
Figure 10: by Service Line Filter Menu Options

2. From the list of options, select one of the service line types to filter by. The SEOC 
list refreshes to display the SEOCs list filtered by the selected service line type.

4.1.2.3. Filter SEOCs by Status

To filter the list of SEOCs by status, follow the steps listed below:

1. From the SEOC home page, select Filter By Status menu.
Figure 11: Filter by Status Menu Options

2. From the list of options select to filter by: All, Active, Date Hold, Discontinued, 
or In-Progress. The SEOC list refreshes to display the status filtered by.



CC SEOC v1.21
Database User Guide 14 December 2023

4.1.2.4. Filter SEOCs by Name

To filter the SEOCs by name, follow the steps listed below:

1. From the SEOC home page, enter the name of the SEOC in the Filter by Name 
(contains) field. 

Figure 12: Filter by Name Field

2. Select the Search button. The Filter by Name Results display.
Figure 13: Filter by Name Results
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4.1.3. Print a SEOC
To print a SEOC, follow the steps listed below:

1. From the SEOC home page, select the SEOC you would like to print.
2. Select View Selected SEOC or tap the selected SEOC to view, the View SEOC 

page displays.
3. Select Print SEOC. The printed SEOC will display in another window. Print or save 

using local browser capabilities.
Figure 14: Printed SEOC Window

4.1.4. Track Version Changes
To track the version changes of a SEOC, follow the steps listed below:

1. From the SEOC home page, select a SEOC with a previous version.
2. Select View Selected SEOC or tap the selected SEOC to view, the View SEOC 

page displays.
3. Select the Track Version Changes button when it becomes active. The Track 

Version Changes page will display.
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Figure 15: Track Version Changes Page

4. Select the Previous Version button. The changes for the previous version will be 
shown. If the previous version is the first version of this SEOC, no changes will be 
displayed.

5. Select the Next Version button. The changes for the next version will be shown.
6. Select the Print SEOC button. The Print SEOC page will display with the current 

changes.
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Figure 16: Print SEOC from Track Version Changes Page

NOTE: By default, Internet Explorer 11 will not print the red and green 
background colors. To print the red and green background colors, check 
the Print Background Colors and Images box in the Page Setup 
dialog from the Print menu.

4.2. Exporting Data

NOTE: Those with a Viewer role are unable to export data.

4.2.1. Export the SEOC Data to an Excel File
To export the SEOC Data, follow the steps listed below:

1. As an Analyst, Coder, Publisher, or Administrator on the SEOC Admin home 
page, select Export. The Export SEOC window displays with the Export SEOCs 
tab open by default.
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Figure 17: Export SEOC Window

2. Select Excel from the Export SEOCs section.

NOTE: Excel exports have a limit of 1,048,576 rows by 16,384 columns. If you 
think you may exceed this, select JSON instead. The steps to export to a 
JSON file can be found in the Export the SEOC Data to a JSON File 
section.

3. Select which status options to include in the export and select Continue. The 
Export SEOC Data Properties display.

4. Select which properties to include in the export and select Export. The SEOC data 
will be exported to an Excel file that you will need to save.

NOTE: If no SEOCs match the export criteria, the following message will display 
“No SEOCs found that match your export request, please select different 
options to export SEOCs.”.
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4.2.2. Export the SEOC Data to a JSON File
To export the SEOC Data, follow the steps listed below:

1. As an Analyst, Coder, Publisher, or Administrator on the SEOC Admin home 
page, select Export. The Export SEOC window displays with the Export SEOCs 
tab open by default.

Figure 18: Export SEOC Window 

2. Select JSON from the Export SEOC Data section.
3. Select which status options to include in the export and select Continue. The 

SEOC data will be exported to a JSON file that you will need to save.

NOTE: If no SEOCs match the export criteria, the following message will display 
“No SEOCs found that match your export request, please select different 
options to export SEOCs.”.

NOTE: Please refer to Appendix A for additional steps on converting the JSON 
file into an Excel file.
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4.2.3. Export the VA PreCert Webpage Data to a JSON File
For all users who can Export SEOC Data, the SEOC Admin UI also allows them to 
export the data required for the VA PreCert Webpage.

To export the SEOC PreCert Data, follow the steps listed below:

1. As an Analyst, Coder, Publisher, or Administrator on the SEOC Admin home 
page, select Export. The Export SEOC window displays with the Export SEOCs 
tab open by default.

Figure 19: Export SEOC Window 

2. Select the Export VA Precert Webpage Data tab. 
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Figure 20: Export VA Precert Webpage Data Tab

3. Select Export. The SEOC data will be exported to a JSON file that you will need to 
save.

Figure 21: SEOC Export Completed Confirmation Message

4. Select OK. The SEOC data will be exported to a JSON file that you will need to 
save. 



CC SEOC v1.21
Database User Guide 22 December 2023

NOTE: Please refer to Appendix A for additional steps on converting the JSON 
file into an Excel file.

5. Troubleshooting
Users may encounter the following errors while using the SEOC UI. 

Table 2: SEOC Error Codes with Descriptions

Error Code Description

204 No Content Found

401 Unauthorized

403 Forbidden

404 Not Found
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6. Acronyms and Abbreviations
Acronym Definition
API Application Program Interface

CC Care Coordination

CCAD Community Care Agile Development

CPRS Computerized Patient Record System

CPT Current Procedural Terminology

HSRM HealthShare Referral Manager

EO Enterprise Operations

JSON JavaScript Object Notification

MVC Model-View-Controller

NSD National Service Desk

OIT Office of Information and Technology

PHI Protected Health Information

PII Personally Identifiable Information

PIV Personal Identification Verification

REST Representational State Transfer

SEOC Standardized Episode of Care

SQL Structured Query Language

SSOI Single Sign-On Integration

UI User Interface

VA Department of Veterans Affairs

VDL VA Software Document Library

VIP Veteran-focused Integrated Process

VistA Veterans Health Information Systems and Technology Architecture
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Appendix A: JSON Instructions
To convert the SEOC JSON file to an Excel file, follow the steps listed below:

1. Open a blank workbook in Excel.
2. Select the Data tab, then Get Data > From File > From JSON. The Import Data 

window displays.
Figure 22: Import Data Window

3. Select the JSON file you downloaded and select Import. Excel will open the file in 
the Query Editor.
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Figure 23: Query Editor

4. Select the List header to the right of SEOCs to display a list of records.
Figure 24: List of Records

5. From the Transform tab, select the Convert To Table icon and select OK. The To 
Table dialog box displays.
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Figure 25: To Table Dialog Box

6. From the To Table dialog box keep the default selections and select OK.
7. Select on the expand icon (<-||->) to the right of the Column1 header to display 

the Search Columns to Expand dialog box.
Figure 26: Search Columns to Expand Dialog Box

8. De-select the Use original column name as prefix check box.
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9. Select OK.
10. Select on the expand icon (<-||->) to the right of the SEOC header to display the 

Search Columns to Expand dialog box.
Figure 27: Search Columns to Expand

11. Uncheck the Use original column name as prefix check box.
12. Select OK. The fields in the SEOC table will be expanded to columns as shown 

below.
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Figure 28: Expanded SEOC Fields

13. Scroll right to the services column, select on the expand icon, and select Expand 
to New Rows to display the records.

Figure 29: Expand to New Rows Menu Option

14. Select the expand icon again and press OK to expand the Payable Services fields 
into columns.
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Figure 30: Payable Services Columns

15. Scroll right to the billingCodes column and repeat the last two steps to expand 
the Billing Code fields into columns.

Figure 31: Billing Code Columns

16. Optional - Repeat the last two steps again for the serviceHptcs column if you 
want to see the cross-walked HPTCs that are sent for each Payable Service.
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17. Scroll right and repeat the last two steps again for the hptcs column to expand 
the HPTC fields that were assigned to each SEOC. 

Figure 32: Expanded HPTC Fields

18. Select the Close & Load option at the left of the ribbon to create load the 
imported data into a spreadsheet tab.

Figure 33: Imported Data
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